Conversion Job Manager

Version 1.88 (DWL66⁺)
# Table of Contents

**Preface**.................................................................................................................................................. 1
  Related Documentation.......................................................................................................................... 1
  Contact................................................................................................................................................ 2

**Chapter 1: General**............................................................................................................................... 3
  Conversion Software Structure........................................................................................................... 3
  Design Rules.......................................................................................................................................... 5
    General............................................................................................................................................... 5
    GDSII............................................................................................................................................... 6
    DXF................................................................................................................................................ 6
    Gerber............................................................................................................................................ 7
    CIF.................................................................................................................................................. 7

**Chapter 2: Setting up a Job**.................................................................................................................. 8

**Chapter 3: Design Format Options**...................................................................................................... 13
  GDSII.................................................................................................................................................. 13
    Layer Frame Options and Controls............................................................................................... 14
    Step Frame Options and Controls............................................................................................... 14
  DXF.................................................................................................................................................. 15
    Layer Frame Options and Controls............................................................................................... 15
    Step Frame Options and Controls............................................................................................... 16
  Gerber............................................................................................................................................... 17
  CIF.................................................................................................................................................... 17

**Chapter 4: Functions of the HIMT Files Frame**.................................................................................... 18
  Text Insertion....................................................................................................................................... 19

**Chapter 5: Justification Options**......................................................................................................... 20
  Expose Window Frame....................................................................................................................... 20
  Place Frame....................................................................................................................................... 21
Chapter 6: Expose Options..................................................................................................................22

Chapter 7: Utilities ....................................................................................................................................24
  The Position Preview Window ..............................................................................................................24
  The HIMT Viewer ..................................................................................................................................25
    Zoom .....................................................................................................................................................26
    Navigation .............................................................................................................................................26
    Tools ......................................................................................................................................................26
    Mode ......................................................................................................................................................27
  Menu Bar ..................................................................................................................................................27
  Message Log ..........................................................................................................................................28
  Layer Info ..............................................................................................................................................28
  The openGL Viewer .................................................................................................................................30
    General ..................................................................................................................................................30
    View Menu / View Tools / Navigation .................................................................................................31
    Mode Menu / Set Mode / Frame Options ..............................................................................................31
    Design Menu / Design Mode / View Options .........................................................................................31
    Measure ...............................................................................................................................................32
    Settings ..............................................................................................................................................32
  The LIC Directory Manager ....................................................................................................................34
  The Job Directory Manager ....................................................................................................................36
  Other Menu Functions ............................................................................................................................38
    File ......................................................................................................................................................38
    Tools ....................................................................................................................................................38
    Help ....................................................................................................................................................38

Appendix A: Layer Merging .........................................................................................................................39

Appendix B: Grayscale Conversion .............................................................................................................41
  Design Rules ..........................................................................................................................................41
    Grayscale DXF Design Rules .............................................................................................................41
    STL Design Rules ..................................................................................................................................41
    BMP Design Rules ...............................................................................................................................41
    XYZ Design Rules ...............................................................................................................................41
    Grayscale DXF Options ......................................................................................................................42
Grayscale Element Options ....................................................................................43
STL Options .......................................................................................................43
Bitmap Options ..................................................................................................44
X,Y,Z Options ....................................................................................................44
General Options ..................................................................................................45

Appendix C: Software Revision History ................................................................47
Preface

This Manual gives an introduction into the Conversion Job Manager graphical user interface (GUI) for controlling the data conversion. The Conversion Job Manager is a very variable tool, which can be used for single design conversion as well as the combination of several designs into various exposure jobs. Thus, it includes a number of complex and variable functions. To get the best results out of the possibilities the software offers, it is important that the user gets a good understanding of how these functions work.

The first two chapters of this manual give general information on the software, and an introduction into the workflow for setting up conversion jobs. In the following chapters, the functions and their settings and options are described in more detail. The last chapter deals with utilities for maintenance and troubleshooting. In the appendix, some processes, configuration-dependent conversion utilities and parameters (e.g. for grayscale exposures), are explained in more detail. In addition, the appendix contains a list of changes issued in newer software versions than the one this manual is based on.

Related Documentation

Heidelberg Instruments offers several further Manuals related to the machine and its operation. If you did not get one of these or need an update, please contact Heidelberg Instruments, Germany.

- **Pre-Installation Guide**
  System requirements, sizes and weights of components etc.

- **User Guide, Part I**
  Step by step instructions for general system usage and standard applications

- **User Guide, Part II**
  Reference Manual for functions of the system GUI (User Menu)

- **Service Guide**
  Maintenance and troubleshooting procedures
**Contact**

Should you need assistance, please call Heidelberg Instruments during normal business hours (CET)

Phone: +49-6221-3430-0  
Fax: +49-6221-3430-30

or contact your local service office:

<table>
<thead>
<tr>
<th><strong>China:</strong></th>
<th><strong>Japan:</strong></th>
</tr>
</thead>
</table>
| Heidelberg Instruments China  
Rm.101, Block 1, Animation Park,  
Yuehai Street, Nanhai Road,  
Nanshan Distr., Shenzhen 518045  
China  
Phone: +86-755-8301599-1 / -2 / -7  
Fax: +86-755-8301599-4 | Heidelberg Instruments Japan  
Germany Center for Industry & Trade  
1-18-2, Hakusan  
Midori-ku, Yokohama, 226-0006  
Japan  
Phone: +81-45-938-5250  
Fax: +81-45-938-5251 |

<table>
<thead>
<tr>
<th><strong>Taiwan:</strong></th>
<th><strong>USA:</strong></th>
</tr>
</thead>
</table>
| Heidelberg Instruments Taiwan  
5F,No. 174 Chung Yang Road,  
Hsinchu City  
Taiwan  
Phone: +886-35311-304/-284  
Fax: +886-35311-243 | Heidelberg Instruments Inc. USA  
2807 Oregon Court, Unit E2  
Torrance, CA, 90503  
USA  
Phone: +1-310-212-5071  
Fax: +1-310-212-5254 |

<table>
<thead>
<tr>
<th><strong>Korea:</strong></th>
</tr>
</thead>
</table>
| Heidelberg Instruments Korea  
#316 Expo Officetel, 381  
Mannyeon-dong, Seo-gu  
Deajeon 302-834  
South Korea  
Phone: +82-42-482-1668  
Fax: +82-42-482-1669 |

You can also reach Heidelberg Instruments via e-mail: himt@himt.de, or visit our site on the Internet: http://www.himt.de
Chapter 1: General

The Conversion Software Package consists of the conversion software itself on the one hand, which in itself again is divided into several programs controlled by one master program, and on the other hand the Conversion Job Manager, a graphical user interface that allows to group parameters for design exposures into logical structures. These structures, and the way the program parts interact with each other, are explained in the first section of this chapter. The second section gives some rules that have to be fulfilled for a design to make it convertible into the machine internal format, called LIC, which is adapted to the way the system is exposing design information.

Conversion Software Structure

When a design is being converted, two kinds of operations have to be executed on the design: Design modifications according to the options and functions chosen, as well as the splitting of the design into the units in which the machine is exposing. Ultimately, the data is stored in the LIC data format, which is optimized for fast processing by the system.

There are several specialized programs for each step on the way, which are all being controlled by the master conversion program, xconvert. This program in itself is being called on by the Conversion Job Manager ("app"), which also accesses some of the programs directly during job setup:
• 2D: gdsii/dxf/gerber/cif; 3D: stl, dxf grayscale, ascii-xyz, bmp:

Depending on the source data type, the Conversion Job Manager program invokes one of these conversion programs with its corresponding command line parameters. The called program then converts the design data into an intermediate format. After the design is processed, the created HIMT file can be checked with the HIMT viewer software. HIMT structure files can also be loaded directly into future jobs if they are stored in the ~/structures directory.

• border:

The border program determines the borders of the design data when a cell is being defined. The result is displayed in the Conversion Job Manager program.

• stripe:

The stripe program performs the first step of the Structure-to-LIC conversion and is called only once. The HIMT Structure data is divided into stripes covering the whole height of the design, where the width depends on the stripe width chosen (maximum stripe width is defined by the - configuration dependent - pixel size and the system’s maximum number of pixels per scan). Each stripe file contains the Structure design data contained within the rectangle representing the stripe, with design coordinates listed relative to the lower-left corner of the stripe. The stripe files remain in Structure format and are stored in the temporary stripes directories.

• xblock:

The xblock program performs the second step of the conversion and is called once per stripe file. Each stripe data set is divided into blocks of 4096 pixels height in the y-direction, and the structures are cut according to these blocks. The resulting polygons are then converted into trapezoids and stored in SDF format (Structure Definition Format). Each SDF file contains data for one stripe. The SDF files are stored in the temporary sdf directories.

• xconvbe:

The xconvbe program is also called once per stripe. It reads in the SDF files, merges (CUTs, ORs or XORs) all layers (if required), and compresses the result into the final LIC format. In addition, the spot size correction is executed in the xconvbe program, which is the most time consuming step of the conversion.
Design Rules

In order to be correctly processed by the conversion software, designs must fulfill certain rules. Some of them apply to all design formats likewise, while others concern only special features of one specific design type.

GENERAL

1. Naming
   - Do not use ‘main’ as name for a layer, cell or any structure.
   - Do not use special characters or spaces in names.

2. Polylines
   - **Polylines must be closed**
     Areas surrounded by a polyline are filled. Therefore, if polylines are not closed, the complete design area is filled. Some data formats allow automatic closing of polylines. Always use this option if available, or make manually sure all polylines are closed.
   - **Do not cross polylines**
     Crossed polylines create ambiguities that can lead to data errors.
   - **Do not create double vertices**
     Double vertices are successive points with identical coordinates. These lead to data errors.

![Polyline drawing rules](image)

Figure 1: Polyline drawing rules
3. Do not put structures into polygons / polylines

When using a polygon or polyline to e.g., define a frame for inverted exposure, the filling will cover any structures inside. Loss of structures as a result of putting a polygon / polyline around them can only be avoided by using the XOR- mode feature. See instructions below regarding XOR-mode if structures should be put within a frame.

4. Single lines without width are ignored.

5. Polygons must show no more than 1,000,000 vertices.

6. Definition or reference depth can be at maximum 16.

7. The number of definitions or references can be at maximum 100,000.

8. Text is not supported (except for DXF).

9. Designs must not exceed the limits of 2000mm from (0,0) in either axis.

GDSII

1. The inclusion of other gdsii files or text libraries are ignored.

2. Node statements in gdsii are ignored.

Also see the information on available design format options for GDSII in Chapter 3 for more information on the GDSII format.

DXF

1. Use a 100% AutoCAD compatible editor

2. Avoid placing structures in layer 0

3. Use the metric system when designing
   • Recommended is the use of Millimeters as basic unit

4. Try to use only the following entities: CIRCLE, POLYLINE / LWPOLYLINE (with or without width), and TEXT.

5. Be especially cautious about correct closing of polylines, when using arcs within a polyline

6. Polylines with widths must not have a change in its widths (tapered lines).

7. Only one font is provided with the dxf conversion package.
   • The dxf standard font will replace any font selected in the DXF-design.

8. Only the following attributes assigned to a text are supported: ROTATION, MIRRORING, SCALING.
9. Different scaling in x and y when inserting a block is not supported.

10. External blocks are not supported.

11. Although our dxf translator supports newer dxf releases, we recommend to use Release 12.

Also see the information on available design format options for DXF in Chapter 3 for more information on the DXF format.

GERBER

1. Do not use incremental, but rather absolute coordinates.

2. Avoid using circular interpolation along with polylines and width.

3. Avoid using apertures without dimensions, e.g., circle with a zero diameter.

4. Flashmode (D3) remains until another drawing mode is chosen (sometimes called modally).

5. To create area-filled polygons, use G36/G37 commands.

Also see the information on available design format options for Gerber in Chapter 3 for more information on the Gerber format.

CIF

1. Definition or reference depth can be at maximum 50.

Also see the information on available design format options for CIF in Chapter 3 for more information on the CIF format.
Chapter 2: Setting up a Job

The geometric arrangement of controls in the Conversion Job Manager indicates the order in which they have to be dealt with when setting up a conversion job. Always work from left to right, from top to bottom.

The following is an example for the setup of a typical 2D conversion job. It shows the workflow to be followed for creating such a job. For the details concerning the options and parameters set on the way, please refer to the following chapters.

1 Start Linux
   Login with user name 'convert' and a password, if one is set (factory password setting: 'convert').

2 Prepare Design
   Copy the design file(s) into the correct directory: CIF files into the subdirectory cif, GDSII files into gdsii, GERBER files into gerber, etc.

3 Start Conversion Job Manager
   Start the graphical user interface (“application menu”) either by clicking on the symbol on the desktop, or - if working directly at the conversion PC - by entering “app” in a shell window.

4 Create New Job
   Click on the New Job icon ( ) to start a new conversion job. In the Set New Job window, insert a job name. In this example, job_00 is used.
5 Define Source File(s)

A register card named job_00 appears directly below the main menu toolbar:

Here, the first two steps of data conversion are controlled: The conversion into the HIMT structure format in the Source File frame, and the modification of structure files (text insertions, reconversion, viewing) in the HIMT File frame.

**Note:** To close a job without saving, click on the cross in the upper right corner of the job’s register card.

Insert a source file into the drop down list of source files by pressing the Add button of the Source File frame. A list of available design types appears: GDSII, DXF, Gerber-RS274, and CIF.

**Note:** In systems with gray scale option, more formats are available in the list. Please refer to the section on gray scale exposures for descriptions on these formats.

Choose the design type of the design to be used in the job. A file selection window with the contents of the related directory pops up, within which the required source file has to be selected. Confirm by clicking on Open. The new file is now inserted in the source file list, and the Design Options window opens. If later a design should be removed from the list, use the Rem button of the Source File frame.

6 Set Design Options

For each design format, different options for design adaptation (e.g., magnification, layer selection, merging, stepping, rotation, mirroring) are available. For explanations on the available options refer to the related Design Format Options section.
7 Create HIMT File

After all options are set, choose Create Default. The design is translated into the structure format with the options chosen, and stored under the same name as the design, but without extension. If a different name should be used, choose Create and enter a new name in the dialog box.

A plate with a single cell is created below the HIMT file section, and the design is automatically added with default parameters derived from the contents.

8 Modify HIMT File

If text should be added to a HIMT File, or a source design should be retranslated using the original options as basis, the functions of the HIMT File frame can be used. Refer to the chapter on Functions of the HIMT File Frame for more detailed information.

9 Set Substrate Options

In the selection list to the right of the design setup frames, select a substrate size. If the required size is not in the list, it has to be entered in the file Xgui/substrates.txt, and the job has to be restarted.

10 Set Exposure Parameters

Now it is possible to select all parameters for the conversion of the design to the LIC format using the control functions of the related cell register card.

Some parameters directly depend on the write lens chosen. If another write lens is selected, the stripe width and the pixel size is automatically updated. Click on the unit buttons behind the values to change the units the values are displayed in.
11 Set Design Parameters

11.1 Check Justification Parameters

Click on **Justification** to activate the justification parameter page of a cell. Borders and positioning of the design on the plate are at first automatically taken from the design. To change these, just click into the boxes and enter the new numbers. Selecting the corresponding checkboxes can activate several additional options. The button **Position Preview** opens the position preview window where the positioning of the design on the plate can be examined. Refer to the section on **Justification Options** for more information.

![Design Parameters](image)

11.2 Choose Expose Options

Click on **Expose Options** to activate the expose options parameter page. Here, some additional parameters like spot size correction values (CD control) can be adjusted if needed. For more information, refer to the section on **Expose Options**.

![Expose Options](image)
12 Save Settings to Job File

Once all options are set, press the **Complete Tasks** button to save the conversion job settings.

13 Start Conversion

Press **Complete Expose Jobs** to start the conversion.

If the LIC data directory that has to be created exists already, a window with a proposal for a name change appears. Click on **Change to Proposal** to avoid the overwriting, or choose **Overwrite All** if overwriting is not critical.

**Note:** Expose jobs linked to the original LIC data might fail if it is overwritten with data converted with different options.

14 Finish

During conversion, a Status Bar shows the current status (Conversion is running / Conversion Finished). Once all tasks are processed successfully, click on the **Finish** button of the Prepare Job window.
Chapter 3: Design Format Options

Before a format can be converted to the unified HIMT structure format, some options have to be set according to the respective formatting rules and the way they can be transferred into a HIMT structure design.

**GDSII**

If a GDSII design file has been chosen as source file, a window opens that shows information about the design, and contains controls to set the available options for design conversion. The GDSII Structure Name of the currently active design is given in the drop-down list at the top. If the name given is not the name of the main structure to be used, any of the other structure names in the design can be chosen from the drop-down list. To the right of the structure name list, Scale factors for stretching or shrinking the design can be set. A different scaling can be chosen for each axis. Any floating point number is valid.

Further controls to set options for the design layers are located in the two frames below the top row: the Layer Frame to the left, and the Step Frame to the right. Explanations for these functions follow.

Once all options have been set, press Create Default to store the resulting configuration information into the corresponding configuration file gdsii.cfg and create an HIMT File with a name extracted from the source file name. If the HIMT File should get a different name for example, because several HIMT Files with different options are to be created from the same source, click on Create and enter a new name in the dialog box. To close the window without saving, press Cancel.
LAYER FRAME OPTIONS AND CONTROLS

In the Layer Frame, a list of the layers present in the design is shown. Each layer is assigned to a layer number and can be selected or deselected by clicking into the leading Layer Checkbox. If there is more than one layer, it is also possible to set operations between layers (<or> (default), <cut>, <xor>). For a further explanation of these operations please refer to the Appendix section on Layer Merging. Also, the order of the layers can be changed by changing the layer names in the drop down list for each layer number. By pressing the STEP button behind a layer name, more options for each layer are activated in the Step Frame to the right of the Layer Frame. At the bottom of the Layer Frame, control buttons give access to additional functions:

- (Un)Select All – all layers in the list are selected or deselected at once
- View One / All – either only the first layer or all the layers are shown in the layer list, and activated in the process (checkboxes set to selected).

STEP FRAME OPTIONS AND CONTROLS

With the controls given in the Step Frame, it is possible to set an array for step-and-repeating a design layer, as well as to mirror, rotate, or shift it. The order of operation is 1) shift and step, 2) rotation, 3) mirroring.

- Step & Repeat:
  - Array – enter the number of columns (X) and the number of rows (Y) for the grid, according to which the design layer should be stepped.
  - Step – set the distances of the rows and columns for the step and repeat function. The unit can be nm, µm or mm. Click on the unit button to cycle through the available units until the correct one is shown.

- Other Operations:
  - X / Y off – enter the distances in X and Y by which the layer should be shifted with respect to the origin. Available units are nm, µm or mm. Click on the unit button to cycle through the units.
  - Mirror – activate the option by clicking into the checkbox, then choose the mirroring axis by cycling through the available options using the axis control button (at x / at y).
  - Rotation – activate the option by clicking into the checkbox. Available rotation angles are 90°, 180°, and 270° clockwise. Choose the rotation angle by clicking on the rotation angle control button.

- Controls:
  - Default – loads the default settings for layers (checkboxes deactivated, array 1 x 1)
  - Update To All – the current settings are copied for all layers of the design
**DXF**

On selecting a DXF design file, a window opens that shows information about the design, and contains controls to set the available options for design conversion.

In the top row of the window, the *dxf units* can be set according to the design grid used. The default setting is 1000000 nm per dxf unit. For designs created in an inch grid, the number should be set to 25400000 nm per unit. If any other grid has been used, adjust the number to the distance in nm used per dxf unit.

In the center of the row, the resolution for arcs is being set. The *arcres (arc resolution)* parameter defines the angle unit used when converting arcs to polylines during conversion from DXF to Structure format. For each “arcres” angle unit in an arc, one polyline point is created. The unit is entered in degrees (Range: 0.1 to 20 degrees)

**Note:** The smaller the angle, the better the approximation to an arc, though conversion time increases. A good value is in the range of 3 to 9 degrees.

To the right, *Scale* factors for stretching or shrinking the design can be set. A different scaling can be chosen for each axis. Any floating point number is valid.

Further controls to set options for the design layers are located in the two frames below the top row: the Layer Frame to the left, and the Step Frame to the right.

Once all options have been set, press **Create Default** to store the resulting configuration information into the corresponding configuration file *dxf.cfg* and create an HIMT File with a name extracted from the source file name. If the HIMT File should get a different name for example, because several HIMT Files with different options are to be created from the same source, click on **Create** and enter a new name in the dialog box. To close the window without saving, press **Cancel**.

**LAYER FRAME OPTIONS AND CONTROLS**

In the Layer Frame, a list of the layers present in the design is shown. Each layer is assigned to a layer number and can be selected or deselected by clicking into the leading *Layer Checkbox*. If there is more than one layer, it is also possible to set operations between layers (<or> (default), <cut>, <xor>). For a further explanation of these operations
please refer to the Appendix section on Layer Merging. Also, the order of the layers can be changed by changing the layer names in the drop down list for each layer number. By pressing the STEP button behind a layer name, more options for each layer are activated in the Step Frame to the right of the Layer Frame. At the bottom of the Layer Frame, control buttons give access to additional functions:

- **(Un)Select All** – all layers in the list are selected or deselected at once
- **View One / All** – either only the first layer or all the layers are shown in the layer list, and activated in the process (checkboxes set to selected).

**STEP FRAME OPTIONS AND CONTROLS**

With the controls given in the Step Frame, it is possible to set an array for step-and-repeating a design layer, as well as to mirror, rotate, or shift it. The order of operation is 1) shift and step, 2) rotation, 3) mirroring.

- **Step & Repeat:**
  - **Array** – enter the number of columns (X) and the number of rows (Y) for the grid, according to which the design layer should be stepped.
  - **Step** – set the distances of the rows and columns for the step and repeat function. The unit can be nm, µm or mm. Click on the unit button to cycle through the available units until the correct one is shown.

- **Other Operations:**
  - **X / Y off** – enter the distances in X and Y by which the layer should be shifted with respect to the origin. Available units are nm, µm or mm. Click on the unit button to cycle through the units.
  - **Mirror** – activate the option by clicking into the checkbox, then choose the mirroring axis by cycling through the available options using the axis control button (at x / at y).
  - **Rotation** – activate the option by clicking into the checkbox. Available rotation angles are 90°, 180°, and 270° clockwise. Choose the rotation angle by clicking on the rotation angle control button.

- **Controls:**
  - **Default** – loads the default settings for layers (checkboxes deactivated, array 1 x 1)
  - **Update To All** – the current settings are copied for all layers of the design
Gerber

Only extended Gerber (RS-274X) is supported.

After the file has been selected, a message window opens, informing the user that all options are set automatically. Editable text box give the possibility of changing the arc resolution setting and the scaling for x and y independently. For scaling, any floating point number is valid. Press Create Default to store the resulting configuration information into the corresponding configuration file gerber.cfg and to create an HIMT File with a name extracted from the source file name. If the HIMT File should get a different name for example, because several HIMT Files with different options are to be created from the same source, click on Create and enter a new name in the dialog box. To close the window without saving, press Cancel.

CIF

If the selected source file is a CIF design file, a window opens that shows information about the design, and contains controls to set the available options for design conversion.

- **Top Cell** – choose top cell number from the list. If set to automatic, the highest number in the list will be used as top cell.

- **Scale X / Y** – the design will be stretched or shrunk by the factor given here. Any floating point number is valid.

- **Layer** – choose from the list which layer should be converted.

Once all options have been set, press Create Default to store the resulting configuration information into the conversion configuration file and create an HIMT File with a name extracted from the source file name. If the HIMT File should get a different name e.g. because several HIMT Files with different options are to be created from the same source, click on Create and enter a new name in the dialog box. To close the window without saving, press Cancel.
Chapter 4: Functions of the HIMT Files Frame

The HIMT File frame serves to directly load existing HIMT structure files into the source list for cells, or to modify designs that were already translated into the structure format. The available functions are:

- **Rem** - Removes a structure file from the list. Does not delete the file itself.
- **Options** - Opens a slightly modified Options window for the source file type from which the structure was created, and loads the creation options used. Can be used to create new structure files with similar options but different names (**Create / Create Default**), or to overwrite the existing structure with data created with different options or a modified source file (**Overwrite**).
- **Insert Text** - While text is usually not supported in the source design files, text lines can be added to the HIMT File using this utility. The structure file has to be selected within the selection list before the button is clicked.
- **Preview** - Shows the selected structure file in the HIMT Viewer. See the section on the HIMT Viewer in the Utilities chapter for more detailed information.
- **openGL Viewer** - Shows the selected structure file in the openGL Viewer. See the section on the openGL Viewer in the Utilities chapter for more detailed information.
Text Insertion

Text lines can be added to any structure file using this utility. When the Insert Text button of the HIMT Files frame is clicked, the Insert text window opens and offers all necessary parameters and functions for insertion of up to 8 texts into the design. To select a text for definition or editing, click on the corresponding register card tag. The text is entered into the Insert Text line. With the functions below this line, the characteristics of this text within a design can be set:

- **Position X / Y** - position of the text within the design. Clicking on the units button changes the unit in which the value is displayed.
- **Letter Width / Height** - size of the letters of this text.
- **Rotation** - set clockwise rotation angle.
- **Mirroring** - choose mirroring axis, if any mirroring should be done.
- **Mode** - sets if the letters should be exposed in *Normal* (letters exposed) or *Invers* mode (letters not exposed).
- **Frame** – Only visible if *Invers* mode has been selected. Sets the size of the area around the letters that should be exposed. Per default, the frame is 1.5 times bigger than the text. To change frame size, change the scaling factor in the *Scale Frame* text line. Does not have to be set if the whole exposure is to be converted in inverted mode.

To view the result of all text design settings, click on **View Text**. To see the text as it appears in the design, click on **View All**. With **Save**, the text is stored within the job. Any text register card that has the **Save and Reload Text** checkbox selected is also stored into a default file and will be available from any job. Any text on a register card that has the **Write Text to Design** textbox selected is merged into the currently selected structure file. **This is irreversible!** To remove a text from a structure file, it has to be recreated from the source file.
Chapter 5: Justification Options

After a cell has been created, the Justification Options page is used to determine the positioning of the design on the plate, how much and which part of the design is to be exposed, and what other operations should be done with the design to prepare it for exposure (Mirroring, Rotation).

**EXPOSE WINDOW FRAME**

The part of a design that is chosen for exposure is called the expose window. In the upper left part of the Expose Window frame, the X: / Y: text boxes show the size of the current expose window. In a new cell, these numbers correspond to the design size as given on the right (Design Width / Height). The numbers in the X: / Y: text boxes are simultaneously updated whenever the expose window borders are changed.

The borders of the expose window can be adjusted either by directly changing the numbers in the Upper / Lower / Left / Right Border text boxes in the lower part of the frame, or by entering the change in the +/- text boxes.

To return to the original border values (i.e. expose window borders correspond to design borders), click on the Reset button.

All numbers can be shown either in mm, µm or nm. To change the unit scale, click on the unit symbol ([mm] / [µm] / [nm]) until the desired scaling is shown. The numbers in the corresponding text boxes are adjusted automatically.
PLACE FRAME

The **Place** frame offers options for design positioning and modification:

- **X / Y off** – shifts the design origin by the distance given. Click on unit symbol ([nm] / [µm] / [mm]) to change the scale.

- **Mirror checkbox** – click into this checkbox to activate mirroring of the design, then choose the mirror axis by clicking on the **at X / Y** button behind the text.

- **Rotate checkbox** – click into this checkbox to activate rotation of the design. Rotation can be done by 90°, 180° or 270°. Click on the rotation angle button (90 / 180 / 270) until the right angle for clockwise rotation is shown.

- **Automatic Centering** – if this checkbox is selected, the design origin is shifted to the center of the expose window borders. The resulting shift is automatically shown in the **X / Y off** textboxes. Useful if alignment is to be done with respect to the plate center.

In addition to these options, the **Place** frame offers a **Position Preview** utility where the positioning of the design on the plate can be controlled. Please refer to the Position Preview Window section in the Utilities chapter for more information. Also, a design preview on the plate is available via the **HIMT Preview** and openGL Viewer control buttons (see the related sections for more information on these viewers). These do however not show the exposure borders, but only the complete design.
Chapter 6: Expose Options

The **Expose Options** page gives control over the exposure mode for each cell. It is divided into four areas:

- **Standard Options**
  - **XOR Mode** checkbox: Enables the XOR mode for all occurrences of stacked structures within the design, as if they were on different layers. For a more thorough explanation of the results of the XOR mode, please refer to the section on **Layer Merging**. Standard setting for stacked structures is OR (merging of the structures).
  - **non invert / invert**: click to choose whether filled structures should be exposed (**non invert**) or not (**invert**). The result on the substrate depends on the polarity of the photosensitive material (e.g., positive / negative resist).
  - **Y-speed**: With the entries in the drop down list, exposure modes with lower exposure speed can be selected (e.g., 0.5 = half exposure speed). In these modes, the lines overlap, resulting in deposition of more energy. Low speed modes allow e.g., to go deeper into thick resists.

- **CD Bias**
  - **ZX / ZY**: also called spot size correction. All exposed areas are adjusted in size by the values given here for x-axis and y-axis, to compensate for the effect of the writing spot diameter. Positive and negative values can be given here, resulting in an increase or decrease in structure sizes. Click on the unit symbol ([nm] / [µm] / [mm]) to change the unit.

  **Note**: The structures are increased or decreased in steps of two address grid units, one per structure side. Any number entered, which is not a multiple of 2 x the address grid (=1/5 pixel), is rounded accordingly.
• **Machine Options**
  
  o **Expose Factor**: Enter a factor for the laser power to be used for this part of the expose job, as compared to the laser power set for the complete job. Unit can be set to %, 1, or 1/1000 by clicking on the unit symbol ([%] / [1] / [1/1000]).
  
  o **Expose Count**: Enables multiple exposing of the design in the same position. The number can be adjusted either by using the + / - buttons or by directly entering the new number into the text box.

• **Advanced Options**
  
  o **Add Frame**: Extends the borders for conversion by the value given in all directions. Can be used to set the limits of a dark exposure at an even distance from the design borders. Changes the border values entered in the **Justification** window.
Chapter 7: Utilities

Several utilities have been developed to facilitate the use of the Conversion Software Manager. The most important of these are the Position Preview Window and the HIMT Viewer / openGL Viewer, which are accessible from several of the different layers of conversion preparation, as well as the LIC Directory Manager for troubleshooting and the Job Directory Manager for system maintenance, which are accessible from the Tools menu of the Menu Bar.

The Position Preview Window

The Position Preview Window is a simple viewer that displays position and size of the design on a standard plate via a frame, and links to additional information. It is accessible via the Position Preview button in the Justification set. The cells are represented as red rectangles, with an i symbol in the upper left corner. The original borders of the design contained in the cell are shown in blue, and an i symbol in the lower right corner of this frame links to information about the design size. Another i can be found at the bottom left corner of the black frame representing the plate.

A left-click on any i symbol adds information about the size of the related structure into the image. A second left-click removes the numbers and arrows again.

Below the plate i symbol, another switch can be found represented by the text line Show Distance / Dismiss Distance. If Show Distance is displayed, clicking on the text adds the distance of the lower left cell border from the lower left edge of the substrate to the image, and the text changes to Dismiss Distance. Clicking on the text again removes this information.
The HIMT Viewer

The HIMT Viewer for viewing designs is a crucible tool for design preparation and conversion optimization. At the same time it can be used to gain more information about the design and the conversion results that are to be expected. It displays the HIMT Structure data created from a source file in a Tcl/Tk based X-Windows interface. It is accessible at several points with the Preview / HIMT Preview button.

The HIMT Viewer consists of two windows: The Control Window and the Display Window. In the Control Window, there are two text boxes showing information on the current status: The Message Log box on the left shows information concerning the current task, like progress and usage information, and the Layer Info box on the right gives general information about the design layers loaded.

On opening, the complete design is automatically drawn in the Display Window, and all relevant information is given in the text boxes of the Control Window. While usually the loading of the design does not take very long, the graphical representation in the Display Window can take several minutes. During that time, a separate window shows a status bar for the drawing tasks. If it is not necessary to view the whole design, drawing can be interrupted at any time by clicking on the STOP DRAWING button in the Control Window. In the same way, any Redraw may be interrupted.

Clicking on the EXIT VIEWER button closes the HIMT Viewer. All tasks are interrupted, and both windows are closed. The Exit function can also be found in the File menu.

The Control Window offers several sets of controls for specific tasks. These are grouped into four frames: Zoom, Navigation, Tools, and Mode. In addition, some more functions can be found in the menus File and Edit of the Menu Bar.

Whenever a function is used which does act directly on the Display Window (like Zoom, or Measurement), the Message Log window shows instructions for the function procedure. However, the following rules generally apply for these functions:

- The button of the active command on the HIMT Viewer changes color to make it easily visible which function is currently active.
- Clicking the center mouse button ends a function.
- New button commands are not permitted until the scroll wheel of the mouse is pressed.
• In two-button mouses, the scroll wheel button can be substituted by clicking both buttons simultaneously.

ZOOM

With the Zoom functions, parts of the design can be enlarged for further inspection. This can be done by using fixed zoom steps, or by choosing the region to be displayed.

• Window – Using the mouse, a region within the current view of the design can be selected. This window is then displayed in a sufficient magnification to fill the Display Window. The Window function is active for only one zoom and has to be selected again if any further zooming is to be done.

• Mouse – Click onto a feature to zoom in or out around it. Left button click, zooms in, right button click, zooms out. Zoom is done stepwise. The function stays active until ended by a scroll wheel button click.

• All – On use of this button, the magnification is reset to a full view of the design.

• In / Out – These buttons allow a stepwise zoom onto or out of the center of the current view.

NAVIGATION

With the buttons of the Navigation frame, the display can be moved Up, Down, Left or Right to view different parts of the design.

TOOLS

The Tools frame contains several useful functions for exposure preparation and design evaluation.

• Measure – This function enables the measuring of distances within the design section currently displayed in the Display Window. While Measure is running, the button is displayed in red. Note that all Zoom or Navigation buttons are deactivated while the Measure function is active.

As soon as the function is started, the Coordinates text box appears in the lower left corner of the Display Window. Whenever the mouse pointer is positioned anywhere within the design window, the x and y position in mm within the design is automatically updated in the Coordinates box. If the HIMT Viewer was started from the LIC Directory Manager, the text box gives additional information on the position within the fracturing structure (stripe, block). Otherwise, these numbers are arbitrary and can be disregarded.

To do a distance measurement, first the left mouse button has to be clicked to initialize a measurement procedure. The mouse pointer changes to a cross, and the online update of pointer coordinates freezes. Now move the cross to the starting point of the measurement and click again. The cross is copied to the position selected, and the display in the Coordinates text box changes to distances, which are again automatically updated whenever the pointer is moved. To end a measurement, click left again. The Coordinates text box returns to showing current pointer coordinates, and the next measurement can be started.
• **Redraw** – Redraws the current view.

• **Show LIC** – this function can only be used if an offline conversion of the design has been done. It can be used to view a LIC file containing a certain structure. After activating the function, click on the structure. A second HIMT Viewer showing only the corresponding LIC file opens.

• **Snapshot** – captures a screenshot of the Display Window and saves it in JPEG format as design#.jpg, where the number # counts up while the Viewer stays open.

  *Note*: Files are overwritten without notice, so it is recommended to rename image files directly after their creation.

**MODE**

The functions of the **Mode** frame determine the way a design is displayed. The options correspond to the options applicable in the Conversion Software Manager. Each mode function stays active until deselected. While a mode function is active, the corresponding button is displayed in blue color.

• **XOR** – The default mode for the display of overlapping structures in different layers is OR. In the XOR mode, overlap regions negate each other (see the Appendix section on **Layer Merging** for further explanations).

• **Toggle** – For Gerber files, this mode has to be activated to get the correct results. Every second design layer is applied as a CUT layer on the previous layer. For multiple layers, this results in a CUT/OR/CUT/OR… sequence. The result is displayed in black and white (no distinction between layers). Does not work in combination with the XOR mode.

• **Fill** – All structures are usually displayed in outlines, i.e. only the structure borders are drawn. In the Fill mode, all exposed areas are filled.

  *Note*: Polygons with too many points cannot be filled. View text messages in the **Message Log**.

• **Polarity** – switches filling mode between clear (not inverted) and dark (inverted) polarity.

**MENU BAR**

• **File**
  
  o **New** – unloads all layers

  o **Add Layer** – adds a design or layer to the already loaded layers. Each new layer is displayed in a different color (**black, red, blue, green**) unless the Toggle mode was chosen (see Mode frame).

  o **Load Layer** – unloads the previous layer(s) and loads a new one.

    *Note*: Apart from structure files, the converted LIC files can also be loaded into the HIMT viewer. See the section on the **HIMT Viewer** in the Utilities chapter for more information.

  o **Unload Layer** – unloads a layer chosen from the **Message Log**.
Save <…> - saves the currently loaded layer(s) in the format chosen. In the case of CIF, DXF or Structure, all layers are saved into one target file, while for Gerber the layers are saved into individual files and a target directory has to be chosen. Only a D10 polygon aperture is used. The Structure 9.0 format is an advanced Structure format that is not compatible with conversion.

- All saving operations overwrite existing files without prompting
- All output data is flattened and so, therefore, the output data may be large
- The output filters only support circles and polygons
- With repeated saving, converting to structure, and reloading, layers can be separated or merged in any combination of design data types

Any of the supported conversion software input formats can be converted to CIF, DXF or GERBER via the Structure format.

Exit – ends all current tasks and closes the HIMT Viewer

Edit

- Setup – shows the parameters used for adding a grid. Adjust parameters to exposure configuration to get correct results.
- List Layers – shows in the Message Log box a list of the layers currently loaded.
- Add / Remove Grid – adds or removes a blue grid showing the fracturing of the data into stripes. Use Setup first to adjust the relevant parameters.
- Save Window – can be used to save a part of a design as a structure file. From the currently displayed design part, a section can be selected using the mouse (follow instructions in the Message Log box) and is saved in the directory ~/structures.

MESSAGE LOG

At startup, the Message Log displays the HIMT Viewer version and revision number as well as the loading information of the current design. While the HIMT Viewer is open, status, usage hints, and all operations are recorded and can be scrolled through.

LAYER INFO

The Layer Info provides information regarding all currently loaded layers. To obtain information concerning an individual layer, scroll through the status list for a report on the layer after loading.

- XMIN, XMAX, YMIN, YMAX – represents the extent of all layers loaded in mm.
- Calls – counts the occurrences of calls, where structures from separate files were added to the current design.
- Circles – total number of circles loaded.
- Polygons – total number of polygons loaded.
- Vertices – total number of vertices (points) in all polygons.
- Max Nr. – gives the maximum number of vertices in one polygon occurring in the loaded layers.
• **Memory** – shows the amount of memory used (approximately).
The **OpenGL Viewer**

The **OpenGL Viewer** is an alternative viewer for designs that is offered wherever the standard viewer is offered. It has some more complex functions and is more intuitive than the standard HIMT Viewer. However, it only works if the system on which the conversion software GUI is being displayed has a graphics board with activated OpenGL support. The Conversion PC delivered with the system is configured for OpenGL. If other PCs are to be used as remote access work stations and this viewer should be made available, please check if the graphics board fulfills the requirements, and if OpenGL support is activated.

However, although the OpenGL viewer in some respects is more practical, for remote access the standard viewer is recommended, as it is significantly faster.

In principle, the OpenGL viewer contains the same functions as the standard viewer. However, they are arranged in a more intuitive way. In addition, the OpenGL viewer offers the possibility to customize the arrangement of functions to individual preferences via dockable tool bars and windows. Key components for the customization are the menu items ToolBars and Settings.

**GENERAL**

All function groups that are available in the top menus **View**, **Mode** and **Design** can also be set up as toolbars. These can be made visible or invisible by selecting or deselecting them in the lower part of the **ToolBars** menu. The **View** functions have in addition been prepared as a graphical function array. This and other function arrays can be selected or deselected in the top part of the **ToolBars** list. Available function arrays are:

- **MinMax** – a window with design size information
- **Navigation** – contains the functions required to view the design (shifting, zoom, redraw, stop drawing) that are contained in the **View** menu and **View Tools** toolbar.
- **Overview** – a small representation of the full design. The section currently displayed is marked.
- **Frame Options** – additional mouse based zoom tools, quick access to measurement window, also contained in **Mode** menu and **Set Mode** toolbar
- **View Options** – options of design display, also contained in **Design** menu and **Design Mode** toolbar
- **Measure** – functions for measurements in the design
- **Statistics** – a window with information about the design contents and the file

---

Conversion Job Manager
Each of these toolbars or function arrays can be freely positioned within the OpenGL window by drag-and-drop with the mouse. The resulting setup can be saved as default together with additional options for customization of the graphical interface in the menu Settings.

**VIEW MENU / VIEW TOOLS / NAVIGATION**

The navigation functions are sorted into a group that is available in the View menu and can be added to the user interface either as toolbar, or as window.

- **The navigation arrows** serve to move the center point of viewing within the design

- **Zoom In/Out tools** to zoom into or out of the design around the current center point in fixed zoom steps

- **Show all**, returns to full representation of the design

- **Redraw**, redraws the full design (not only the visible part)

- **Stop drawing**, immediately stops redrawing. Is useful e.g., to stop redrawing as soon as the visible part is finished.

In addition to the navigation tools, the design can also be shifted via drag-and-drop in the design window.

**MODE MENU / SET MODE / FRAME OPTIONS**

- **Mouse zoom**: a left-click into the design zooms into that part of the design

- **Window zoom**: by click-and-drag, a region can be marked that will be stretched to fill the complete viewer window

- **Measurement**: opens the measurement function array if not yet open, disables mouse-based zoom functions (mouse-clicks are captured for measurement)

**DESIGN MENU / DESIGN MODE / VIEW OPTIONS**

- **Fill / lines / points**: Selects the form of representation of structures.

- **Color**: Swaps between multicolor and foreground/background representation (1 color for all layers) of the design. If color is selected, each layer is displayed with a different color. Which colors are used and in which order they are assigned to the layers can be adjusted in the Settings menu.

- **Invert**: In fill mode, by default, the insides of structures are filled. If invert is active, all open areas are filled instead. Settings for foreground and background coloring can be changed in the Settings menu.

- **XOR**: Shows the result if an XOR operation is used instead of OR wherever structures overlap. Automatically activates the fill mode.
MEASURE

With the Measure function set, measurements can be done within the displayed design. While the Measure mode option is active, the positions of two left-clicks into the design are captured and the coordinates appear in the Measure function set in the two coordinate sets P1 and P2.

As soon as two positions have been captured, the distance in X and Y, as well as the overall distances are displayed below the coordinate set. The base units for positions and distances can be selected by clicking on the units button and cycling through the available units (\text{[mm]} /[\text{um}]/[\text{nm}]). The button always shows the currently active unit as caption.

If a wrong position was captured accidentally, or just one point should be changed, each point can be deleted by clicking on clear. To blank all fields, click on Reset.

In between the two capturing clicks, any other functions can be executed, like changes in position or zoom. To avoid accidental capturing, it is recommendable to set the mode to a zoom mode during this.

SETTINGS

In the Settings Menu, the settings of the viewer components can be customized.

Show Layer Info

If selected, a window shows a list of all layers in the design, plus the merge operations that are used during flattening. If color mode is active, the color of each layer is displayed in a box beside the name. Layers can be selected or deselected for viewing by selecting or deselecting the checkbox.

Load Font

Opens a dialog window where a different font can be chosen for the GUI. Setting is changed only for the current session. If the font new font should be used generally, use the Edit Start Settings function to save the selection.

Edit Start Settings

In the Edit Start Settings window, the default settings of the graphical user interface can be customized. The function consists of several tabs for the different item groups that are affected:

Options: For general settings of the graphical user interface. Size and position of the GUI can be read from the current status or entered manually and saved to be used as default. Different modes can be selected and saved to be used as default. If a different font was selected, or the selection and/or arrangement of toolbars and windows were changed, the current status can be saved as default.
Colors: Here, the colors that are used for different layers in color mode can be customized. The order in which the colors are assigned to layers can be changed with the arrow buttons, and colors can be added to or removed from the list. With the reset button, everything is returned to factory setting (white/black-red-green-blue-yellow-magenta-cyan-gray). Background color can be swapped between white and black (inverse layer color adjusts accordingly), and the behavior of the GUI in cases where the number of layers is larger than the number of colors in the list is determined. Also, the default color mode can be set (one color – deactivated, multi colors – activated).

Settings only become active if they are saved and the viewer is restarted.
The LIC Directory Manager is a tool to inspect the LIC files created in an offline conversion. To start it, choose LIC Directory Manager in the Tools menu of the Conversion Job Manager Menu Bar. A list of available LIC directories is loaded. Depending on how many offline jobs are still present on the workstation, this might take a minute or two. The list can be sorted either by name, date or size of directory data. Click on Sort <mode> to rotate through these options. To accelerate the loading of the list, it is possible to delete whole directories by highlighting them and clicking on Delete. This information can then only be regained by repeating the conversion.

Whenever a LIC directory is highlighted in the list, some relevant information is being displayed in the text boxes on the right. This includes the names of the job file and the expose job therein used for conversion, the design source file, the date when the conversion was done, the size of the LIC directory, and the number of LIC files contained in it.

If a certain LIC file should be viewed in the HIMT Viewer, choose the LIC file from the drop down list and, if known, enter a block number into the corresponding text box before pressing Show. If the LIC file name is not known, it is also possible to gain the information using the HIMT Viewer. In the LIC Directory Manager, click on All. The HIMT Viewer opens and loads the complete Structure source file for the LIC data into the viewer. Now, zoom into the region of interest (for usage information on the HIMT Viewer see the previous section). Once the structure that should be viewed in the LIC format is within the Display Window, click on Show Lic in the HIMT Viewer Control Window. Now, move the mouse pointer on the structure. The numbers for stripe and block are given in the lower left corner, together with the pointer position coordinates. By clicking onto the structure, the corresponding LIC file and block is loaded.
In both cases, a modified HIMT Viewer opens, with additional controls for LIC viewing:

Use Add Previous / Add Next to add the neighboring blocks to the blocks already loaded. To load a specific block, enter its number into the Blocknumber text box and click Add, or Goto, if all other blocks should be unloaded first. To move from block to block within the LIC file while displaying only the current block, use Previous and Next.

Zooming in onto the LIC data shows the gray values used, e.g. at a structure border:
The Job Directory Manager

For each job, files and directories are created in several places of the conversion home directory:

- All conversion job relevant data is stored in a subdirectory of the directory Xgui
- Source data is read from the different source file directories (cif, dxf, gdsii, gerber)
- All configuration data needed for exposure is sorted into exposure job directories in the directory job
- The converted LIC data files are stored in separate LIC data directories in the main directory

Manual maintenance of all these files and directories would be a time-consuming task. The Job Directory Manager serves for fast and easy cleanup and backup of the job related directories and files. It is accessible form the menu via Tools → Job Dir Manager.

Upon startup, the Job Directory Manager reads all relevant information from the data directories. Depending on the amount of data present, this might take a while. Once loading is complete, all jobs available are listed in the selection box on the left, and the topmost job is automatically highlighted. The listing is done in alphabetical order. Click on the Sort Date button below the selection list if the jobs should be sorted by date instead.

On the right, all components connected with the selected job are listed together with the disk space they cover. Each can be selected separately for the maintenance task planned by clicking the related checkbox:

- **Convert Job** - stands for the conversion job file and the related subdirectory of the Xgui directory
- **with Source File(s)** - represents all source files used within the conversion job. The drop-down list contains all source files for information, but only all or none can be selected.
• **with Exposure Job(s)** - represents all exposure jobs created from the conversion job. The drop-down list contains the names of all exposure jobs for information, but only all or none can be selected.

• **with Target Dir(s)** - stands for all LIC data directories that were created for conversion of the cells. The drop-down list contains all job related LIC directories for information, but only all or none can be selected.

After the required job components for the maintenance task planned have been selected, two different maintenance operations can be done: **Backup Selected** or **Delete Selected**.

In both cases, after clicking on the function button, a window opens showing the selected contents for confirmation:

**Backup**: If Backup is confirmed by clicking on the **Backup** button, a directory selection window opens where the target directory for the backup can be selected. This directory can also be a network drive. Depending on whether or not **use TAR/GUNZIP** was selected, either all selected files and directories are first archived and zipped into one file, or just copied directly to the selected target directory.

**Delete**: All files and directories listed in the table are deleted.

To restore a job from the backup location, click on **----> Restore Jobs**. A directory selection window opens. Select the directory where the backup data is stored.
**Other Menu Functions**

The main menu and the toolbar of the Conversion Software Manager offer several standard functions in addition to the specialized functions discussed above:

**FILE**

The functions offered in the *File* menu are the standard functions for Jobs and the GUI itself. All of them are also represented by icons in the toolbar. In addition, it offers a list of the last four jobs that were edited for fast reloading.

- **New Job** – creates a new job, prompting the user for a name. If a job is already open, it has to be closed first, by clicking on the X button in the upper right corner of the Job level page.
- **Load Job** – select a job file (not a directory!) from the file list to load it
- **Save Job** – saves the current job under a given name
- **Exit** – closes the Conversion Job Manager GUI. Hotkey: Ctrl+Q.

**TOOLS**

Besides utilities discussed above, the *Tools* menu offers the following options:

- **Set Fonts** – to change the fonts used in the Conversion Software Manager. A separate window opens where from lists a different font type, style and size can be chosen for the graphical user interface. Factory standard is Adobe Helvetica, Normal, 9pt.

**HELP**

The help menu offers some helpful information for using the Conversion Software Manager:

- **About** – shows the version and contact information. Can also be opened with hotkey F1. The Conversion Job Manager Version can also be read from the user interface title bar.
Appendix A: Layer Merging

Some of the design formats that can be converted to LIC are layer based (DXF, GDSII). Also, generally structures can overlap within a design. In both cases, the treatment of overlapping structures has to be defined, sometimes by the user, sometimes by the software.

The available operations for merging are logical operations. Currently, the commands CUT, OR and XOR are supported for layer merging, OR and XOR for overlapping structures. For a better understanding, these operations are explained here graphically with an example:

- **OR** results in a true merging of the structures,
- **CUT** subtracts a layer from the previous layer,
- **XOR** leads to a cutting only in the overlap region, while elsewhere both structures remain intact.

Only the **CUT** operation is dependent on the order of operation.
Multiple layers can be merged using different operations:

Layer1 CUT Layer2 XOR layer3
or
Layer1 XOR Layer2 XOR layer3

In this example, the desired result can even be obtained by two different combinations of operations, as the XOR and the CUT operation are identical as long as the second structure is completely within the first one.
Appendix B: Grayscale Conversion

The conversion software accepts four input formats for Grayscale structure conversion:

- DXF-designs where each layer corresponds to one of the 128 gray levels (Grayscale DXF)
- 3-dimensional STL design elements
- Bitmap (BMP) image elements
- X,Y,Z ASCII format

Only DXF format may be used for larger design. All other formats may be used only for creation of small elements, which are then stepped over the substrate.

Design Rules

GRAYSCALE DXF DESIGN RULES

In addition to the standard DXF rules, the following rules apply:

- Structures on different layers may not overlap; each layer may only contain those areas that are to be exposed with the corresponding gray value.
- With complex structures, file sizes might increase above the limit manageable by the conversion software. Try to keep structures as simple as possible.

STL DESIGN RULES

So far, only STL elements are supported by the conversion software and can be stepped to form a larger array. Within these limits however, few rules apply.

- STL element size may be max. 100x100µm
- everything has to be designed within the positive octant
- only binary STL files are supported

BMP DESIGN RULES

As in STL, also in BMP only elements are supported so far, which can then be stepped over a larger area.

- BMP element size may be max. 1000x1000 pixels

XYZ DESIGN RULES

XYZ-ASCII designs have to be stored in a subdirectory called `xyzel`.

- Format is X,Y,Z with one point per line
- Unit is µm
- Points have to form a grid with equal spacing in X and Y
- Element size may be max. 1000x1000 points
- File may be saved with any extension
Grayscale DXF Options

The Grayscale DXF Options window offers the same general functions as the standard DXF Options window:

- **DXF units** - size of one design unit, in nm
- **Arcres** - arc resolution; angle unit used during translation of arcs to polylines, in degree
- **Scale X/Y** - stretches or compresses the complete design in the given axis

In the Layer frame to the left, a gray value has to be assigned to each design layer. The STEP button activates the Step frame for a design.

The Step frame on the right contains the same typical functions to step, shift, mirror or rotate a layer as the standard DXF Options window does. In addition, it offers the possibility to load this data from an existing step file, if the Import File for Step checkbox is selected. This file has to contain the information on X offset, Y offset and rotation for each occurrence of a layer in a separate line. The unit for the offset parameters is determined by the entry in the External Units text box, and the rotation direction can be selected with the Rotation button (clockwise / counterclockwise). Set these parameters before clicking on Load External File. The data contained in the file is used for all layers of the design.

**Note:** Stepping and repeating complex 3D structures over a large area requires large hard disk storage space!

**Notes on external step files:**
- parameters have to be separated by spaces
- no header line is allowed
- unit for rotation is degrees
Rotations are per default executed around the coordinate origin. If rotation should be executed around a different point, the coordinates of this point have to be entered into the Center Position text boxes (Set Center X / Set Center Y). In case the rotation should be executed around the design center, and this is not at the same time the design origin, the system calculates these parameters from the origin borders when the button Calculate Center is pressed. The result of the calculation is displayed in the Center Position text boxes.

Once all options are set, an HIMT File with the same name as the source file (Create Default) can be created, or a different name can be chosen (Create, enter name in dialog box). To close the window without creating an HIMT File, click Cancel.

**Grayscale Element Options**

The conversion of any 3D element in STL, BMP or XYZ-ASCII to an HIMT File requires two steps. First, the element has to be translated into an intermediate 8-bit grayscale bitmap. The options and functions necessary for this can be found in the upper left frame and differ depending on the input format (STL, BMP, XYZ). Design size parameters are shown and should be checked to make sure everything is correct. Please note that the final height in the exposed design depends on parameters of exposure and processing and cannot be controlled here. After the intermediate bitmap is created, the parameters for translation into HIMT system code have to be set.

**STL OPTIONS**

**STL units** - enter the unit size the element was created with. Check on the values returned for **Size X** (width), **Size Y** (length), and **Height** to verify that the correct unit was used.

**Resolution** - sets the resolution the image is created with. The available resolution values are listed in a drop-down list. The value selected should be as large as possible without losing structure elements, to reduce data bulk.

**Inversion** - determines if the maximum height should be interpreted as maximum exposure depth (gray level 100%, no inversion), or minimum exposure depth (gray level 0%, inversion)

**Mode** - selects which of the element borders (lower / upper) is the one that has to be scanned for grayscale value determination
BITMAP OPTIONS

View – opens the source file in a separate BMP viewer (e.g., xview)

Set Gray Range – by default set to 0-127, this defines in what range base the gray values in the BMP should be interpreted. The value range given here is mapped to the available number of gray values in the system. So, if 0-63 is defined, 63 is translated to the maximum available gray value, and all values in between are interpolated accordingly to values in between.

Pixel Translation – defines the size of one BMP pixel. Check on the overall size given below this entry when changing it to make sure the result is of the correct size.

Inversion – select if 0 should be the lowest (no) or the highest (yes) gray value.

X,Y,Z OPTIONS

Pixel Size – enter the distance between pixels that has been used during element creation. Entering a wrong value here will lead to gaps or overlapping between points

Inversion – select if 0 should be the lowest (no) or the highest (yes) gray value.
GENERAL OPTIONS

After all parameters in the format specific section are set, click on Generate Image to create an intermediate 8-bit grayscale bitmap (temporarily saved in raw format in the main directory) and display it in the image frame. If the result is wrong, repeat image generation with different parameters until the result is satisfactory.

For the translation of the bitmapped element into a structure element for Lic file generation, the pixel size has to be chosen. As the basic pixel size is determined by the write lens used, first select the Write Lens from the drop down list. Now, the Gray Pixel drop down list contains several possible pixel sizes for Lic file generation. Depending on the design structure, it might be recommendable to interpolate to double or quadruple pixel size. This decreases the Lic data size, and some structures get better surface quality with less grayscale resolution. Which structures work best with which resolution should be determined by test exposures.

With the invert LIC option, the direction of structure imprint into the resist can be changed including the surrounding area that may be extended when setting the borders (in contrast to the Inversion option of the translation into a bitmap, where only the element itself can be inverted). To check on the resulting gray level distribution, click on Generate Image again after all parameters are set, and then click on Show Lic Sample. An HIMT Viewer window opens that shows the system gray levels that will be entered into the LIC file. Refer to the section on the HIMT Viewer in the Utilities chapter for more information on the functions of the HIMT Viewer.

Usually, the gray levels of the bitmap are linearly translated into the gray values available in the machine. However, it is possible to select a different mapping of bitmap levels to machine levels via a user defined graytable. When the checkbox use Graytable is selected, a predefined gray table can be selected from the drop-down list beside it. Alternatively, the Edit button can be clicked to open the Transforming Gray Values window where a new table can be defined. The left column of the displayed table shows the default value for a gray level, the right column can be edited to adjust the gray level step sizes e.g., to adapt to the behavior of a certain resist, or to change the value limit to an in-between value. To reload the default value into the editable column, click on Take Default. To completely clear all entries from the editable column, click Clear. With the Load button, a predefined gray table can be loaded and viewed or edited. Once editing is finished, use either the Overwrite <table file name> button to store the edited data under the same name, or the Save as button to choose a different name. To close the window and return to the element options window, click on Quit.
**Note:** Graytable files can also be edited directly in the directory Xgui/gvt. However, it is important that the standard format is preserved.

The right part of the Element Options window contains a Step frame similar to the ones used in 2D Design Option windows (DXF, GDSII), but for design stepping only. Either an array for element distribution can be defined with fixed pitches for each axis, or an external file can be loaded in which positions and rotations for the element occurrences can be defined freely. This file has to contain the information on X offset, Y offset and rotation (in degree) for each occurrence of the element in a separate line. The unit for the offset parameters is determined by the entry in the **External Units** text box, and the rotation direction can be selected with the **Rotation** button (clockwise / counterclockwise). Set these parameters before clicking on **Load External File**. Rotation is automatically executed around the center of the generated bitmap (i.e., usually the center of the element).

**Note:** Stepping and repeating complex 3D structures over a large area requires large hard disk storage space!

**Notes on external step files:**
- parameters have to be separated by spaces
- a separate line for each occurrence is required
- no header line is allowed
- unit for rotation is degrees

After all design specific options are set, continue with the **Justification Options** as explained above. The **Exposure Options** are not available for gray value exposures.
Appendix C: Software Revision History

This section contains relevant additions, changes and bug fixes issued after the version this manual is based on.

<table>
<thead>
<tr>
<th>Version</th>
<th>Revision</th>
<th>Affected Section</th>
<th>Change</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.8</td>
<td>8</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>